
Microsoft OneNote cheat sheet

Frequently used shortcuts
Ctrl + Shift + G Put the focus on the current 

section

Shift + F10 Open the context menu

Ctrl + N Add a new page at the end of 
the selected section

Ctrl + O Open a notebook

Ctrl + G then press the Down or Up arrow 
key to select a different 
notebook, and then press Enter 
Switch to a different notebook on 
the Navigation bar

Ctrl + T Create a new section

Ctrl + Alt + N Create a new page below the 
current page tab on the same 
level

Ctrl + Alt + Shift + 
N

Create a new sub-page below 
the current page

F11 Enable or disable the full page 
view

Ctrl + Alt + G Put the focus on the current 
page tab

Ctrl + Alt + M Move or copy the current page

Ctrl + Shift + A Select the current page

Ctrl + Shift + T Jump to the title of the page and 
select it

Ctrl + E Open a search box to search all 
currently open notebooks

Alt + F1 Show / hide open notebooks 

Navigation
Using these keys, you can navigate through OneNote 
for Windows 10 without using mouse.

F6 Jump between the tab bar, 
navigation pane, and the page 
canvas

Down arrow Move to the ribbon on a tab

Left arrow / Right 
arrow

Move among the options on a 
ribbon

Enter Execute the currently selected 
option

Left arrow / Right 
arrow

Move between tabs

Tab or Shift + Tab Move between the items on the 
main menu bar

Alt Open the ribbon

Alt + H Open the Home tab

Alt + N Open the Insert tab

Alt + D Open the Draw tab

Alt + W Open the View tab

Narrator
Win + Enter Activate Narrator in Windows

Caps Lock + Esc Exit Narrator

Type and edit notes
Ctrl + M Open a new OneNote window

Ctrl + Shift + M or 
Win + Alt + N

Create a Quick Note

Ctrl + Alt + D Dock the OneNote window

Ctrl + Z Undo the last action

Ctrl + Y Redo the last action

Ctrl + X Cut the selected text or item to 
the Clipboard

Ctrl + C Copy the selected text or item to 
the Clipboard

Ctrl + V Paste the contents of the 
Clipboard

Home Move to the beginning of the line

End Move to the end of the line

Left arrow Move one character to the left

Right arrow Move one character to the right

Ctrl + Left arrow Move one word to the left

Ctrl + Right arrow Move one word to the right

Backspace Delete one character to the left

Del Delete one character to the right

Ctrl + Backspace Delete one word to the left

Ctrl + Del Delete one word to the right

Shift + Enter Insert a line break without 
starting a new paragraph

Shift + F10 or 
Context menu key

Open the context menu for the 
object in focus

Execute the action suggested on 
the Information Bar if it appears 

Ctrl + Shift + W
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at the top of a page

Format notes
Ctrl + Shift + H Highlight the selected text

Ctrl + K Insert a hyperlink

Ctrl + Shift + C Copy the formatting of the 
selected text (Format Painter)

Ctrl + Shift + V Paste the formatting to the 
selected text (Format Painter)

Enter Open a hyperlink when the 
cursor is in the link text. Press 
the arrow keys to move the 
cursor to the link text

Ctrl + B Apply bold formatting to or 
remove it from the selected text

Ctrl + I Apply italic formatting to or 
remove it from the selected text

Ctrl + U Apply underline to or remove it 
from the selected text

Ctrl + - (-) Apply strikethrough to or 
remove it from the selected text

Ctrl + Shift + = Apply superscript formatting to or 
remove it from the selected text

Ctrl + = Apply subscript formatting to or 
remove it from the selected text

Ctrl + . Apply bulleted list formatting to 
or remove it from the selected 
paragraph

Ctrl + / Apply numbered list formatting to 
or remove it from the selected 
paragraph

Ctrl + Alt + 1 Apply Heading 1 style to the 
current note

Ctrl + Alt + 2 Apply Heading 2 style to the 
current note

Ctrl + Alt + 3 Apply Heading 3 style to the 
current note

Ctrl + Alt + 4 Apply Heading 4 style to the 
current note

Ctrl + Alt + 5 Apply Heading 5 style to the 
current note

Ctrl + Alt + 6 Apply Heading 6 style to the 
current note

Apply Normal style to the current Ctrl + Shift + N

note, clearing all formatting

Alt + Shift + Right 
arrow

Increase paragraph indent

Tab (at the beginning of a line) 
Increase paragraph indent

Alt + Shift + Left 
arrow

Decrease paragraph indent

Shift + Tab (at the beginning of a line) 
Decrease paragraph indent

Ctrl + R Right-align the selected 
paragraph

Ctrl + L Left-align the selected paragraph

Ctrl + Shift + > Increase the font size of selected 
text

Ctrl + Shift + < Decrease the font size of 
selected text

Ctrl + Shift + R Show or hide rule lines on the 
current page

Add items to a page
Win + Shift + S Copy a screen clipping to the 

Clipboard (requires the Windows 
10 Creators Update)

Alt + Shift + D Insert the current date

Alt + Shift + F Insert the current date and time

Alt + Shift + T Insert the current time

Shift + Enter Insert a line break

Alt + = Start a math equation or convert 
selected text to a math equation

Tab Create a table by adding a 
second column to already typed 
text

Tab Create another column in a table 
with a single row

Enter Create another row when in the 
last cell in a table

Ctrl + Enter Create a row below the current 
row in a table

Alt + Enter Create another paragraph in the 
same cell in a table

Ctrl + Alt + R Create a column to the right of 
the current column in a table

Create a row above the current 
one in a table (when the cursor 

Enter
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is at the beginning of any row, 
except for the first row)

Del (press twice) Delete the current 
empty row in a table (when the 
cursor is at the beginning of the 
row)

Select notes and objects
Ctrl + A Select all items on the current 

page. To expand the selection, 
keep pressing Ctrl + A

Shift + End Select from the current cursor 
position until the end of the line

Shift + Down 
arrow

Select the whole line (when the 
cursor is at the beginning of the 
line)

Ctrl + Shift + T Jump to the title of the page and 
select it

Esc Cancel the selected outline or 
page

Alt + Shift + Up 
arrow

Move the current paragraph or 
several selected paragraphs up

Alt + Shift + Down 
arrow

Move the current paragraph or 
several selected paragraphs 
down

Alt + Shift + Right 
arrow

Move the current paragraph or 
several selected paragraphs 
right (increasing the indent)

Alt + Shift + Left 
arrow

Move the current paragraph or 
several selected paragraphs left 
(decreasing the indent)

Ctrl + Shift + - Select the current paragraph and 
its subordinate paragraphs

Del Delete the selected note or 
object

Home Move to the beginning of the line

End Move to the end of the line

Left arrow Move one character to the left

Right arrow Move one character to the right

Alt + Left arrow Go back to the last visited page

Alt + Right arrow Go forward to the next visited 
page

Ctrl + Alt + P Play selected audio recording

Stop playback of selected audio Ctrl + Alt + S

recording

Ctrl + Alt + A Start new audio recording

Ctrl + Alt + Y Rewind the current audio 
recording by 10 seconds

Ctrl + Alt + T Rewind the current audio 
recording by 5 minutes

Ctrl + Alt + U Fast-forward the current audio 
recording by 10 seconds

Ctrl + Alt + I Fast-forward the current audio 
recording by 5 minutes

Tag notes
Ctrl + 1 Apply, mark, or clear the To Do 

tag

Ctrl + 2 Apply or clear the Important tag

Ctrl + 3 Apply or clear the Question tag

Ctrl + 4 Apply or clear the Remember for 
later tag

Ctrl + 5 Apply or clear the Definition tag

Ctrl + 6 Apply or clear the Highlight tag

Ctrl + 7 Apply or clear the Contact tag

Ctrl + 8 Apply or clear the Address tag

Ctrl + 9 Apply or clear the Phone 
Number tag

Ctrl + 0 Remove all note tags from the 
selected notes

Use outlines
Alt + Shift + 1 Show through Level 1

Alt + Shift + 2 Expand to Level 2

Alt + Shift + 3 Expand to Level 3

Alt + Shift + 4 Expand to Level 4

Alt + Shift + 5 Expand to Level 5

Alt + Shift + 6 Expand to Level 6

Alt + Shift + 7 Expand to Level 7

Alt + Shift + 8 Expand to Level 8

Alt + Shift + 9 Expand to Level 9

Alt + Shift + 0 Expand all levels

Tab Increase indent by one level

Shift + Tab Decrease indent by one level

Alt + Shift + + Expand a collapsed outline
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Alt + Shift + - Collapse an expanded outline

Specify language settings
Note: To change the writing direction in notes, you 
must enable right-to-left languages in the Microsoft 
Office Language Preferences tool.

Ctrl + Left Shift Set left-to-right writing direction

Ctrl + Right Shift Set right-to-left writing direction

Tab Increase indent by one level in 
right-to-left text

Shift + Tab Decrease indent by one level in 
right-to-left text

Work with pages and Quick Notes
F11 Enable or disable full page view

Ctrl + M Open a new OneNote window

Ctrl + Shift + * Expand or collapse the tabs of a 
page group

Ctrl + P Print the current page

Ctrl + N Add a new page at the end of 
the selected section

Ctrl + Shift + [ Increase the width of the page 
tabs bar

Ctrl + Shift + ] Decrease the width of the page 
tabs bar

Ctrl + Alt + N Create a new page below the 
current page tab at the same 
level

Ctrl + Alt + Shift + 
N

Create a new sub-page below 
the current page

Ctrl + A Select all items. To expand the 
selection, keep pressing Ctrl +  A

Ctrl + Alt + G Select the current page

Alt + Shift + Up 
arrow

Move the selected page tab up

Alt + Shift + Down 
arrow

Move the selected page tab 
down

Ctrl + Shift + T Move the cursor to the page title

Page Up Scroll up on the current page

Page Down Scroll down on the current page

Ctrl + Home Scroll to the top of the current 
page

Scroll to the bottom of the Ctrl + End

current page

Ctrl + Down arrow Go to the next paragraph

Ctrl + Up arrow Go to the previous paragraph

Alt + Down arrow Go to the next note container

Home Go to the beginning of the line

End Go to the end of the line

Left arrow Move one character to the left

Right arrow Move one character to the right

Alt + Left arrow Go back to the last visited page

Alt + Right arrow Go forward to the next visited 
page

Ctrl + Alt + + or 
Ctrl + Alt + Shift + 
+

(+ on the numeric keypad) 
 Zoom in

Ctrl + Alt + - or Ctrl 
+ Alt + Shift + -

(– on the numeric keypad) Zoom 
out

Ctrl + S Save changes and sync 
notebook

Not: OneNote çalışırken, notlarınız her 
değiştirildiğinde otomatik olarak kaydedilir. Notları elle 
kaydetmek gerekmez.

Work with notebooks and sections
Ctrl + O Open a notebook

Ctrl + T Create a new section

Ctrl + Tab Go to the next section

Ctrl + Shift + Tab Go to the previous section

Ctrl + Page Down Go to the next page in the 
section

Ctrl + Page Up Go to the previous page in the 
section

Alt + Home Go to the first page in the section

Alt + End Go to the last page in the section

Ctrl + Alt + M Move or copy the current page

Ctrl + Alt + G Put focus on the current page 
tab

Ctrl + Shift + G Put focus on the current section 
tab

Ctrl + G then press the Down or Up arrow 
keys to select a different 
notebook, and then press Enter 
Switch to a different notebook on 
the Navigation bar
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Ctrl + Shift + G or 
Shift + F10

Open the context menu of the 
current section

Search notes
Ctrl + E or Ctrl + F Open a search box to search all 

currently open notebooks

Down arrow While searching all notebooks, 
preview the next result

Enter While searching all notebooks, 
go to the selected result

Press Ctrl+E, Tab, Tab, Down arrow to change the 
search scope

Esc Dismiss Search and return to the 
page

Share notes with other people
Ctrl + Shift + E Open the Share pane

Ctrl + Shift + E then press Tab, Tab, Enter to 
create a sharing link for the 
current page

Ctrl + Shift + E then Tab, Down arrow, Down 
arrow to share the current 
notebook

Ctrl + Shift + E then Enter to send a copy of the 
page via another app

Share notes with other programs
Ctrl + Shift + E then Enter to send a copy of the 

current page via another app

Ctrl + S or Shift + 
F9

Sync current notebook

F9 Sync all notebooks

Ctrl + Q Mark the current page as read or 
unread

Protect notes
Ctrl + Alt + L Lock all password-protected 

sections

More
Ctrl + Alt + 7 Give feedback to Microsoft

If you want o use accessibility options to navigate in 
OneNote, please refer to this page.

To get started using a screen reader with OneNote, 
refer to this page.
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